
 

 

 
 
 
 
 
 

PRSIM User Manual v1.1.0 

 

 

 

 

January 4, 2023 
Initial 



 
PRSIM User Manual v1.1.0 

 

 

 
  Page 1 

 

CONTENTS 

1. OVERVIEW ....................................................................................................................... 1 

2. DATA EXPORT .................................................................................................................. 2 

3. DATA IMPORT .................................................................................................................. 3 

3.1. NETWORK TABLE ............................................................................................................................... 5 
3.2. DYNAMIC DATA TABLE ....................................................................................................................... 6 

4. SCHEMATIC DEVELOPMENT ............................................................................................. 7 

5. PSCAD CONVERSION ...................................................................................................... 10 

6. MULTIPORT NETWORK EQUIVALENT .............................................................................. 13 

7. DYNAMIC DEVICES ......................................................................................................... 15 

8. TRANSMISSION LINES .................................................................................................... 16 

9. PSCAD USER LIBRARY ..................................................................................................... 18 

9.1. GLOBAL SUBSTITUTION .................................................................................................................... 18 
9.2. SINGLE COMPONENT SUBSTITUTION ................................................................................................... 19 
9.3. LOCAL NAME IDENTIFICATION AND SUBSTITUTION ................................................................................ 20 

10. RUNNING PSCAD CASE ................................................................................................... 21 

 

 

 

 



 
PRSIM User Manual v1.1.0 

 
 

 
  Page 1  

 

1. OVERVIEW 

The PRSIM (PoweR System IMporter) import tool can convert PowerFactory DIgSILENT (PFD) and PSSE 

network data to PSCAD format which may be used to conduct electromagnetic transient simulation 

studies. PRSIM bridges the gap in the user transition from the phasor to the EMT domain platforms. 
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2. DATA EXPORT 

PowerFactory versions (2019, 2020 and 2021) must first be converted with DGS version 6.00 in the XML 

file format which can then be imported by PRSIM. On the PSSE side, RAW file version 33 is preferred 

however versions 29, 30, 31, 32, 34 and 35 are also supported. To export PFD or PSSE network 

information, activate the case and execute the loadflow calculations, then save the loadflow results to 

one of our supported versions. These results will be used later in PRSIM to initialize the PSCAD 

components to the same steady state operating point. 

PowerFactory users exporting component parameters and loadflow results must also use the definition 

file provided in the PRSIM support folder named DGS Export Definitions v110. This will ensure the 

correct parameters are identified and exported to the XML file. Users must import the definition file into 

their PFD database and then they will see a list of the PowerFactory parameters chosen for each 

element to be exported. Once the user performs the export process with the definition file, an XML file 

will be generated that can be imported into PRSIM. 

RAW format 33 is preferred for exporting PSSE loadflow results. Bus locations, dynamic information for 

synchronous machines, and sequence data for various elements of the circuit may be exported using 

LOC, DYR, and SEQ files respectively. The generated RAW, DYR, SEQ and LOC files may be used to 

translate PSSE information into PSCAD. 
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3. DATA IMPORT 

You can launch PRSIM using the icon or menu item if you have it installed on your computer or by using 

the MyUpdater software. Once you have PRSIM running you will be able to import your previously 

generated xml or raw file into PRSIM. Begin by adding a New PRSIM case in the project folder under File 

tab of PRSIM. 

 

In the New tab you can:  

1. Set the folder location here. 

2. Set the name of the file here. 

3. Make sure New Case is selected then Press the Create button to create a new PRSIM file 
which will be added to the workspace tree. 
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In the Workspace window right click on the new case in the project tree and select Import RAW Data or 

Import DGS Data to launch a browse dialog that you can use to select your xml or raw data file. 

Click on the Open button to start the import process. If the data file is valid a set of data rows will be 

generated in the Network Table pane. 

 

If you skipped or failed to import data in the previous step, open one of PRSIMs example cases by 

navigating to the File menu and click on the Examples button. 
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Your PRSIM will have a PowerFactory or a PSSE folder depending on your purchase. Navigate to the 

IEEE_9 folder and open the example case you find there. 

 

3.1. Network Table  

Once you have a case with a network loaded you will be able to view the data in the Network Table 

pane. You can use the dropdown list to view and visually verify the data in each table. 
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The Network tables represent information extracted from the PSSE or PowerFactory files. You can now 

draw a single line diagram of the buses you want to see in PSCAD. And if your case is large, you can 

create a multiport equivalent of the remainder of the network. 

3.2. Dynamic Data Table 

If your case has dynamic information, you can view it in the Dynamic Data pane. The table below shows 

dynamic data from the PowerFactory/Kundur example case. 
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4. SCHEMATIC DEVELOPMENT 

Once you have imported your data into a PRSIM case you can develop the single line diagram (SLD) 

view. In the Home tab click the Expand Bus button or Expand All if your network is very small. 

 

• Expand Bus will launch a pop-up window named BusSelectionForm, where you can select a 
start bus to begin your expansion. Additional filtering is available if you need to search for a bus 
in a large system. 

• Expand All will attempt to expand the entire network into the active canvas view. Once a bus 
has been selected in the BusSelectionForm, click Ok to transfer it to the canvas and the network 
will be expanded until the canvas limits are reached or the network has been completely 
expanded. Don’t worry, you can go ahead and if it fails or is too messy you can Undo or clear the 
canvas of the components you don’t want. Removing components on the canvas will not 
remove them from the network. 

• The Levels droplist can be used to expand any given bus outward by the radius amount. 

Additional expansion options are also available in Layout tab. 

 

• Layout Method: 

o Star Layout expands bus up, up and left, up and right, down and left and down and right 
(in a star pattern). 

o DropDown Layout expands buses down and then to the right. 
 

• Use Coordinates: If your case has a coordinate file or was exported from PowerFactory this 
option can accelerate the bus expansion as there is existing coordinate data for the bus 
locations.  

• Use Subpage Coordinates: Enable this option if your case has subpage coordinates. 

• Filter Buses by Coordinates: Enable this if your PowerFactory case has multiple diagrams. 

• Area, Zone, Owner: You can filter the buses that get expanded by AREA, ZONE and OWNER. 
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• Lock Connections will ensure that bus and branch connections remain intact as you edit the 
schematic. 

• Disable Draw Horizontal Buses if you want them oriented vertically. The default expansion 
direction will change to the right and then down. 

Use the Expand Bus button to launch the BusSelectionForm, then you can select a start bus to begin the 

expansion process. Once you have a bus on the canvas you can continue the expansion by clicking on 

the  (plus icon) on the bus. 

 

 

 

 



 
PRSIM User Manual v1.1.0 

 
 

 
  Page 9  

 

If your case has coordinate data and Use Coordinates is enabled, the buses will be automatically be 

positioned to their proper location on the PRSIM canvas. Otherwise, you can move and resize the buses 

to your liking. Buses with a lot of branches can be automatically sorted by clicking on them to gain focus 

and then use the S key to sort the branch end points. 
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5. PSCAD CONVERSION 

Generating a PSCAD case may be done by selecting Export Network which will translate the schematic 

and PFD/PSSE information into a PSCAD EMT case. In this case, we’ll use the default export settings. A 

detailed explanation for all available options under Export Settings will be provided in the following 

sections.  

Clicking on Export Network button will launch the process to create a new PSCAD case and populate it 

with an equivalent PSCAD component for each network component in PRSIM. A script is run for each 

component to reads data from the network table and perform property computations which are then 

applied to the corresponding EMT components. Any remaining parts of the network that were excluded 

from PRSIM canvas will be represented with a network equivalent circuit on PSCAD side. 

 

If you right-click on the PSCAD project and select Show Script Computations, you can review script 

computations that were performed for each component in the Output window. 
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You can access and review the conversion scripts for each component by right-clicking on the model and 

selecting Edit Scripts… and then select the model displayed in the sub menu. You will see the Convert-

PSSE or a Convert-DGS script in the script editor. The script for converting a PSSE AC_LINE is shown 

below. Hover the mouse over a variable to display tooltip information about it. If you right-click on the 

window the Insert Symbol menu contains component parameters as well as column names in the 

AC_Line table that can be used in the script equations. 

 

The conversion scripts are computations sections intended for converting PRSIM component parameters 

to PSCAD component parameters. In this case, the target is the Line_ManualYZ component inside a 

PSCAD tline module. 
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When multiple definitions are needed for a 

component, they are selected using logic in the 

Select-Model script. The script shown to the right 

is used to select between a fixed_load in the 

master library and a capacitive or inductive 

source in the PRSIM library. 
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6. MULTIPORT NETWORK EQUIVALENT 

When a network is large or the area of interest is smaller than the total network you can create and use 

a schematic of the area you want to export and include a multiport network equivalent representing the 

rest of the network.  

To do this, select Export Settings (or Export Network) under the Home tab as shown below.  

 

In the dialog you can verify that Included is selected in the Export/Network Equivalence dropdown list. 

If you haven’t already done so, you can now generate a new PSCAD case by clicking on Export Network. 

A network equivalent will appear as a module one or more ports representing the connection points 

from the network equivalence to the rest of the system at the boundary buses. 
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If the accuracy of generated Network Equivalent module is required, users may generate a test case 

during export. The option Project Settings/Create NETEQ test module, will generate a test case that you 

can use to verify the accuracy of Network Equivalent Module at each boundary bus. 
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7. DYNAMIC DEVICES 

PRSIM supports system dynamics provided your PowerFactory DGS or PSSE DYR network file has it. 

PowerFactory dynamics are automatically processed during the import process so all you need to do is 

verify it is there by examining the dynamics table. If you have a PSSE network, you will have to import 

the DYR file (see menus under the project tree) after you have imported the RAW file. 

 

Applying system dynamics will replace network source models with detailed equivalent dynamic models 
which may be a combination of a synchronous machine, exciter, turbine, and governor as shown below.  
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8. TRANSMISSION LINES 

Two primary types of line models are included in PRSIM that are used in the generation of PSCAD 

transmission lines, Pi-section and Bergeron line. However, the Selection script shown below will 

override these if specific conditions are met. 

 

Note that you are not limited to the predefined models in the PRSIM library. The next section will show 

you how to specify on any other type of transmission line models and include them in the conversion 

process. 

The PI-section is the first pre-defined transmission line model in the Export Settings. By selecting this 

type from the AC-Line Model section and then converting the network as shown below, all transmission 

lines will be replaced with PI-section equivalents regardless of their actual length. 
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For the IEEE14Bus system, selecting PI-Sections will produce in the following PSCAD case where all the 

transmission lines are represented by their PI-section equivalent. 

 

Bergeron T-Lines is the second option. If this option is selected, PRSIM will replace all long transmission 

lines with their Bergeron equivalents whenever the travel time of the line is greater than the selected 

simulation time step. Time step is accessible under Runtime Settings category in Export Settings. 

Otherwise, transmission lines will be replaced with PI-sections automatically.  

Selecting Bergeron T-Lines for mapping the IEEE14Bus example to PSCAD will produce the following 

simulation case. 
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9. PSCAD USER LIBRARY  

PRSIM provides a User library feature that will allow you to replace selected standard library 

components with your own custom models. Users can fully customize the models and scripts that 

calculate the target component parameters. The custom models may include detailed page module 

components as well as black box components. One application of the User library feature is to replace 

generators with dynamic models including exciters, governors, and power system stabilizer components. 

Another application is considered here to replace transmission lines with detailed models that include 

tower geometry and conductor information. 

The User library can be used in three modes:  

• Global substitution 

• Single component substitution 

• Local name substitution 
 

9.1. Global Substitution  

This feature substitutes all of the components from a user-defined PSCAD library. The substitution 

library that you developed must first be loaded into PRSIM workspace tree. Following that you may 

optionally set it as a start up library in the Default Models dialog under File tab. Once there, PRSIM will 

always load your library along with the master and PRSIM libraries. 

 

You can enable your new custom library in your project by selecting it in the Project Settings dialog. 
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During the export process for the specified project, PRSIM will first search the user library for any 

matching Interface definitions. If found, your custom definition will be used otherwise the process will 

revert to the default definition for that branch type located in the PRSIM library. 

9.2. Single Component Substitution 

Single component substitution is used when a custom model is needed as a replacement for a specific 

component in the schematic. Select the properties menu on a specific branch component on the 

schematic then use the droplist to select an alternate model. 
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9.3. Local Name Identification and Substitution  

Local name substitution is an alternative method for specifying custom components. This approach 

requires the user to name their definitions according to PowerFactory element names (loc_name) or 

using our standard naming convention for PSSE networks. PRSIM will automatically select the 

components that conform to these local naming conventions. 
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10. RUNNING PSCAD CASE 

To run the generated PSCAD file simply click the Launch PSCAD on the ribbon. PRSIM will launch the 

PSCAD version that is currently active in PRSIM.  

• If you have more than one V46 and V50 PSCAD version, you can select your preferred version in 
the Application Options/PSCAD Executables.  

• PRSIM will attach any dependant libraries to your case when it launches PSCAD 
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